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GeneMarker Manual

General Overview

Main Analysis Window

There are four major displays in the main analysis window.

1. Navigator; Sample File Tree
2. Electropherograms
3. Report; Report Table
4. Project Summary
See Helpful Icons Index for further details.

%, GeneMarker HID - Athen031016 16-19 edited SGF
File View Project Applications Tools Help

ERNE & H-9 8 K -l &

1~

B v | b v | Maker o ]

[E=SF=R =y

]

pasisse

ele e e
e e R

Bah DhmaxEExEEEaE)
i
5

]
»
3

B} &b EhhbhbnnannanaEEnEEEEREEDREmEEEE

e
LI e

ER=y e BEl| | ] Report B W
7 () 0l-4ng DNAZs_AD1 001fss  [0g-Alelic_Ladder_1_HO1 015,52 (08-Alelic_Ladder_1) — Allelic Ladder b3 I =
5 i . [File Heme s
(\) 02-4ng_DNAZh_BO1 003.fsa
v LR e i il [Desti7e [ oizsast |[piesaaa] | FoA | fazsiod [01—4ng_oiaz= 3
+/ 04-2ng DNAZ2a_ D01 007.fsa [_wwa | [ D2tst1 |[p7sezo|[ psssie | [ TPox |pvsas |o=-
E 05-2ng_DNAZ>_ED1_009.fsa) D18s51 | [ D251338 | [CSFIPQ Penta D 23
B Dbggn NNAT- FN1 N14 =
Bo A pasizss] [Disiese|paseaipiosizepizsar] =]
k. 50 100 150 200 250 300 350  4B00MN4so  spdfVsso 600 -
o %g— | I’ X
=4
2000 |‘| I =
mm ‘ 75 |osing owazn A
i 210 [11-500pg DNAZC|E
1,000 | 211 [12-soopg_owmza @
e 212 |13-s00pg_DNRZH @
D LD: 17-Allelic_Ladder_2. ATS soo | 213 [14-250pg_DHAzc| @Y
~[@ 18-150pg_DNA2a B03 0034 T1e F
19-150pg_DNAZb_CD3_00S = === 1t [te-250ps DAZH|M
20-150pg_DNAZc_DO3_007.1) = ==
21-125pg_DNAZa_E03_008.f 36 [zoisedpg ol i
22-125pg_DNAZb_F03_0114| 217 |19-150pg_DNAZ!
23-125pg_DNAZc_G03_013.1 218 |z0-150pg DNAZC|EF
24-100pg_DNA2a_HO3 01 215 |ai-125pg DNRza@
7 25-100pg_DNAZh_AQ4_00; i i
? 26-100pg DNA2C B04_004.F S Fi
? 27-75pg_DNA25_C04_006.65 £
? 28-75pg_DNAZb_DO4_008.fs| 222 r}
? 29-75pg_DNAZC_EO4 010,75, LN BT Fi
; 30-50pg_DNAZa_F04_012.s = T — e
? 31-50pg_DNAZb GD4 0i4.fs| >z
VWA 1511 |[prsezo][ ossete | [ TrRox |pvsas] 25
, 325000 PNAZC_HO4.016.5 “‘ [baisii |forseol| cesaie | [ Teox Jovsse] =
? 33-30pg_DNA2s_AD5_001.fs| 165539|] D18S51 [Mbesisss | [ Pentan ] G
? 34-30pg_DNA2Zb_B0S_003.5 A [o1stase]pzseaipiosizaprasarr] [ peniaE | RSN 28-S0 Do Y
4 35-30pg_DNA2c_C05_005.f5 s0 480y, 200 250 300 350 400 450 500 S50 €00 Rl
? 36-25pg_DNAZa D05 007.f5| o z
2 37-25pg_DNA2b_E05_D0S. fs 2000 ﬂ ) v EFT
? 38-25pg_DNAZC_FO5_011.f5, i ‘ =n
? 39-15pg_DNAZ3_G05_013.f5 ; o
; ) LD: 40-Alelc_ Ladder - 6,000 232
7 41-15pg_DNAZD_A0S_002.fs LEd
? 42-15pg_DNAZC_B05_004.fs, 4,000 ey
? 43-7.5p0_DNAZa_C06_006.f 735
? 44-7.5pg_DNA2Zb_D06_008.f 2,000 236
? 45-7.5pg_DNAZC_E06_010. l o
? %-3.2509_DINA22_FO5 012, il L sl - A L . =
? 47-3.25g_DNAZh_G06_014]
? 44-3.25g_DNAZc_HOG_016. - as
? 49-0pg_a_A07_00Lfsa 220 [35-7.5pg WAz
? 50-0pg_b_BO7_003.fsa 241 [14-7_5pg_piam)
? 51-0pg_c_C07_005.fsa >4z |15-7.5pg_DNAzc
52-Amp_Pos_a_D07_007.fsa - =
E = 223 |16-3 25pg_DNAZ
< i 0 0.0 =
(66580/100120140 161802001225, 250./275| 300.325. 351 0.0 744 |47-3.25pg DNAZ]
Pagellp  PaneDown 122122(304245250256254 325 250 248 253]235 250 102 2 ]
56 samples PC error: 0/0 NC error: 0/0 Ladder error 4/5 gged=52
T g

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax

software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER




FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual
Status:Published Document ID: 6311
DATE EFFECTIVE APPROVED BY PAGE
04/20/2017 Nuclear DNA Technical Leader 2 OF 33

Navigator; Sample File Tree

This view lists all the samples that are included in the project. Prefixes LD, PC and NC are labeling the
allelic ladder, positive control and negative control

The sheet icon to the left of the sample name indicated the quality of the internal lane standard (ILS) with
the following color/code:

i.  Green = High Lane Quality; Passing Size Standard
ii. Yellow = Requires Verification B

iii. Red strike through = No Sizing Occurrence; failed to call size O

iv. Red Question Mark = one or more quality criteria are not met based on the analysis
parameters; See Quality Reasons Index for moreidetails:

Project Summary

This bar located at the bottom of the main ahalysis screen'summarizes the project as well as alerts the
analyst to samples that did not pass analysis parameters.

Mew 22 samples PC errordd/1 NCerror @3 Ladder error: 0/1 #Failed=1 #Flagged=19
1. New reflects therdata set is not a project that has been previously analyzed.

a. If the first column reads Modified, the project was previously analyzed in the software.

2. The second column denotes the number of samples (including controls) contained in the data
set.
3. Columns'3-5 indicate the number of controls in the data set that do not meet the quality

criteria'set in the software.
4. Column 6 denotes the number of samples that were disabled.

5. Column 7 denotes the overall number of samples, except the allelic ladder, that do not meet
the quality criteria set in the software.

NOTE: Flagging features are an indication of potential failures. The ultimate decision of
passing/failure is made by the analyst after further evaluation.
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Calibration Chart Window

There are three major displays in the

1. Sample List
2. Size Standard Template
3. Sample ILS

calibration chart window.
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This view lists all the samples that were processed in the project. The Score column represents how well
the size standard template and the sample ILS match. The closer the score is to 100, the better the match.
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The sample may fail automatically if the size standard is bad enough, or may have to be failed manually
by the analyst.

Size Standard Template

The template highlights all the peaks that should be labeled in the corresponding sample ILS for easier
comparison.

Samples ILS

The sample ILS displays the peaks that were detected. As well as the approximate start of the data
analysis view, indicated by the dash line.

Browse by All Color Window
There are four features in the Browse by All Color that allowsfor straightforward review of the sample.

Sample Drop-Down
Max Chart Number
Scroll Within a Sample
Scroll Between Samples
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Sample Drop-Down

The sample drop-down lists all the samples within a project. A user can move between samples by
clicking on the sample name instead of scrolling through all electropherogramst

Max Chart Number

Max chart number views each sample by the number of dye lanes as per thediser’s needs during sample
analysis.

Allele Labels

When analyzing samples in the Main Analysis window or the' Browse by All Color window, alleles may
be colored yellow or red.
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This indicates that one or more quality criteria have not been met in the software. See Quality Reasons
Index for more details.

NOTE: Flagging features are an indication of potential artifacts and/or allelic imbalance, or peak
saturation. The ultimate decision of passing/failure is made by the analyst after further evaluation.
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Peak Table

When analyzing samples in the Main Analysis window or the Browse by All Color window, a peak
table maybe added to supplement analysis by clicking Show Chart/Table icon

= 1 a4 B P |

| DEsi17g | | D11 | [ oFseza | [ WEEFIPO |
100 150 200 250 500 50

1,200 W 4
1,100 l
1,000
ain |
a0 4
70
i )
500 4

400 -

[11,274.9.456] [123293,702]
Mo, | Dye Size Heigh‘ﬁdarker ‘.&IIBIB Guality Score | Allele Comments Guality Rea...
1 Blue 957 176 -'___ 957 Undeter... 1.3 oL
2 Blue 1437 1183 DBS1173 13 Pass 121.7
3 Blue 207 Ban, 828 D251, 30 Pass 100.6
4 Blue 2708 B2 D7SE200 ) 10 Pass 461
& Blue 274.9% ) 456 D755820 1 Pass 271
& Bl 321 N 1154 CSRIPO 10 Pass 371
7 Blue 3233 A2 CSF1PO 12 Pass 46,5

This table will indicate to an analyst which alleles were flagged and which quality reason was triggered.
See Peak Table Options Index for further details.

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax
software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual
Status:Published Document ID: 6311
DATE EFFECTIVE APPROVED BY PAGE
04/20/2017 Nuclear DNA Technical Leader 7 OF 33

I1. Load Data

1. To start your project, go to File — Open Data — Add

1. Navigate to the network folder containing the data files (i.e. the .fsa files) to
be analyzed.

il. Select files to add (include only one ladder per project)
i. Hold Ctrl key to select multiple files
il. If analyzing all files hold Ctrl and A'keys
1il. Select Open
i. Ensure correct files argyadded to list

1v. Deselect Auto-Elevate

B9

Open Data Files

File List:

SRunessI D28 mmturesiRun, HS1 20070126 118544 Al f=a 2dd b
CARurghlD 28 migtuessRun_HS51C2007-01-26_113%34-_pe fza
ARURNDES mikturesiRun ST 2007-01-26_113035_pe2 fza
ARun_HS1, 2007-07-265993436-_Buccal_27-28 18bfsa

MRun HS1_2007-01-26_113%37-_Buccal_27-28 1-5c.fsa
ARun HS1R2007-01-26_113438-_Buccal_27-28 1-10afza

Remaove
LFuf_HS T_2007-01%26_113439_Buccal_27-28_1-10b.fza a Al
\Rum HS1_2007-01-26_ 113440 Buccal_27-28_1-10c.fsa EMavE

“Ruh_H51_2007-01-26_113441—_Buccal_27-28_1-20a.fsa
SAun_HS 1_2007-01-26_113442_Buccal_27-28_1-20b.fza

“Run_HS1_2007-01-26_113443-_Buccal 27-28_1-20c fsa

Data
[
A
I:hg
kit
M
bzt .
KA
[ IS
M:A.
WA
BN

PLik

Add Folder...
Default
ﬁ Cha  dz..| [ AutoElevate ] Ok | Cancel ‘

V. Select OK

2. Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.
1. If they are not, right click on the sample name in the Sample File Tree —
Set Sample Type — Select appropriate sample type
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3. Click Run Project located in the top toolbar. | |

III. Run Wizard

1. In Template Selection window, select the appropriate existing

a. PowerPlex Fusion® LI7Z

Template Mame: IFusiun

Parel:  |Fusion_OCME =
Size Standard: IILSEUD |
Standard Calor: | DRANGE |

Analyziz Tope:

b. Yfiler
late Name: [YFiler
Panel. |yfiler_0CME =
Size Standard:  [L1Z_vfier Ry
Standard Color | ORANGE |
Analysis Type: [HID ~]
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2. Click Next

3. In the Data Process window, ensure the following settings are used based on

amplification kit.

a. PowerPlex Fusion® / PowerPlex Fusion®' STRmix™

Run Wizard
Set data process optionz

Faw D ata Analyziz
v Auto Range [frame)

a =

Bazeline Subtraction:

[~ Saturation Repair

I save ‘

[v Superior [ Classic 40 Enhanced | |

[~ Pullup Comection [ Spike Remowval

Size Call " 4 N
f* Local Southem CubigaSpline

J NS =

Data Process - HID Analysis

Allele Call =5 v

E [ duto Range [bps)

mm =] W |

[v Smooth [~ Enhanced Smooth

I Min Intenaty: |50 =
0 -

Percentage »

<< Back

End [510 =

PealD etection Threzhold: ﬂ

M an [ntensity:; | 32760 5

Global b ax

Mote: Use Fanel Editor to set kin Intensity
and % Global Max for peaks within Markers

LCancel
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b. Yfiler®
[ Run Wizard @

Data Process - HID Analysis

Set data process optionz

Faw D ata Analyziz Allele Call " 4 A W 4
[ Auto Range [frame) ia [~ Auto Range [bpg]
Start; 2300 = End: (3000 =% Start |79 vﬂ End (110 =
v Smooth [ Enhanced Smooth Peak. Detection Threszhold: il

Baseline Sublraction: Min InfeReitgyf75 \\ 2] Max Intensiy: [20000 %

[~ Supenaor |w Clazzsic [ Enhanced
|| Percentage » |3 = Global tax

MNotes lUse Fanel Editor to set kin Intensity

[v Pullup Comection [ Spike Remowval
[~ Saturation Repair

. and “20Global Max for peaks within Markers
Size Call = U
f* Local Southem " Zubic Spline | |
E Save ' = i << Back | Meut =» | LCancel

4. Elick Next

5. Inthe Additional Settings window, ensure the following settings are used:
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a. PowerPlex Fusion®/ PowerPlex Fusion® STRmix™

-

[ Run Wizard A @

Additional Settings - HID Analysis

Set additional ophtions related to the different analpsiz lwpe

L]

i
LA |

[v Bt Select Best Ladder

Pozitive Control Template: |P'F‘_Fusi|:|n _*_I ’ W Auto Panel Adjustment

Allele Evaluation G .

Peak Score:
Reject < |0.00 Check [1.00 < Pazs |

[ Misture Evaluation A 4 v

e Seve, | ezt | «wgaok | [ Cancel

1. Allelic Ladder:

a. NONE is selected (grayed out, change not possible)
il. Auto Select Best Ladder:

a. Box is Checked

iil. Auto Panel Adjustment:
a. Box is Checked

iv. Select the Positive Control Template using the Positive Control dropdown:
a. For PowerPlex Fusion® - PP_Fusion

v. Allele Evaluation Peak Score:

a. Reject 0.00
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b. Pass 1.00
Vi. Deselect Mixture Evaluation
b. Yfiler®
rF{un Wizard y S (=
Additional Settings - HID Analysis
Set additional options related to the different analysiz type Box

" 4 /__ -

@utn Sélect Best Ladder

’ [v Auto Panel Adjustment

02-allelic_Ladder_1_B01_003.fsa

, Manually selectiladder for
Peak Scare: -
Reject < W Check |1.00 < Pasz apalysisifirom drop down

Allelic LMder:

Positive Contral Template: [ filer MPC

Allele Evaluation

[ Mimture Evaluation A VvV 4 D 4

ﬁ‘] S - | I << Back Ok Cancel

1. Allelic Ladder:

a. Select appropriate ladder for analysis from the drop down box.
1l. Auto Select Best Ladder:

a. Box is Unchecked

iil. Auto Panel Adjustment:
a. Box is Checked

iv. Select the Positive Control Template using the Positive Control dropdown:
a. For Yfiler® - Yfiler MPC

V. Allele Evaluation Peak Score:

a. Reject 0.00
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b. Pass 1.00
vi. Deselect Mixture Evaluation

Note: Do NOT click Save within the Data Process Window. This will
overwrite the template for all analysts.

6. Click OK — Once data has finished processing Click OK

7. On the top left corner of the screen, Click File — Click Save Project — Navigate to
desired folder and save project using the naming systemfbased on'the instrument, date,
injection number(s), kit and analysis set (i.e. Newton090615 811U A)

IV. Checking the Allelic Ladder

1. There are two areas in the Main Analysis#vindow that indicate if the allelic ladder used for
analysis has passed.

a. Inthe Sample File Tree, a red question mark next to the allelic ladder would indicate a

potentially failed ladder.
b. Inthe Project Summary, aladder error would indicate a potential failed ladder.

2. Right click in the Sample File Tree = Click Select Max. Open the Browse by All Color Window

icon g Visually confirm all expected alleles in the allelic ladder are present.

3. If the ladder used for analysis failed, click File from the menu bar - Click Open Data »>
Highlight the failed ladder from the Data File List = Click Remove > Click Add... > Navigate
to the .fsa files = Select a different ladder for analysis = Click Open > Click OK. Return to
Section II. Load Data, step 2 and proceed.

V. Checking the Size Standard
[7]

1. Located on the top toolbar in the main analysis window, Click Size Calibration

2. In the Calibration Charts window, Click Chart Synchronize ~
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3. Click Sample Name header to sort samples in order. In the Sample List, either Click on a
Sample or Navigate using the Up/Down Arrows, check the size standard for each sample as
per the amplification kit.

a.

C.

If the peak is recognized by the software, a green inverted triangle appears at the top of

the peak. '

If the size standard needs manual editing by adding or deletingia peak; Right Click on
the desired peak — Select Delete/Add Peak — Right Click Again — Select Update
Calibration

Close Calibration Charts window.

i.

ii.

If any sample is automatically marked as disabled by the software, review the
size standard in the Calibration Charts window to ensure this was due to failing
or poor size standard. If it is confirmed,thatthe sample has a failing or poor size
standard, a rerun code must be‘applied to that sample. Right click on the sample
in Sample File Tree withinMain Analysis Window = Click Edit Comments -
Enter rerun code in Comments,field = Click OK

If any sample has failing or poor size standard, and was not automatically marked
as disabled byithe software, any peak labels present must be deleted. Open the
Browse by/All Color analysis window = navigate to the relevant sample(s) >
highlight all. peaks in one dye by holding down Ctrl, left click and dragging
aroundiany peaks present in that dye = click Delete to remove the peak labels>
répeat for each dye. Right click on the sample in Sample File Tree within Main
Analysis Window - Click Edit Comments = Enter rerun code in Comments
field > Click OK

4. In the Main Analysis window, Click on the Down Arrow next to the Show Color " icon
located in the top toolbar. — Click Hide All

5. Inthe Sample File Tree, Right Click on Allele Call —Click Select Max

6. Inthe Main Analysis window, Click on the Down Arrow next to the Show Color " icon
located in the top toolbar. — Click ORANGE
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7. Adjust axis to view size standard depending on amplification kit
Y,
a. On the top toolbar, Click Set Axis icon
b. Click Fixed ‘X’ — enter X axis range
i. PowerPlex Fusion® = 55-510
ii. Yfiler® = 75-410
c. Click Set Axis again — Select Auto Fit Y

Note: Analysts can zoom in/out by using the zoom icons N located at the toptoolbar. As an
additional option, hold down the left button on the mouse and drag the dotted box that appears from the
upper left to the lower right (around the desired “zoom in” area).To zoom out, hold down the left button
on the mouse again dragging the box from lower right to upper left.\To scroll while zoomed in, right click
and hold while dragging the mouse in the direction you wantite. scroll.

8. Review size fragments by ensuring that all required peaks are labeled within +/- 0.5bp of the
fragment size.

a. Ifa peak is not labeledgthen the size standard fails.

i. Right click on sample in Sample File Tree within Main Analysis Window >
ClicksEdit Comments = Enter rerun code in Comments field 2 Click OK

ii. Ifany sample withfailing or poor size standard has peaks called, the peak labels
of those peaks will need to be deleted. Open the Browse by All Color analysis
window > navigate to the relevant sample(s) = highlight all peaks in one dye
by holding down Ctrl, left click and dragging around any peaks present in that
dye. > click Delete to remove the peak labels—> repeat for each dye

Size Standard

PowerPlex Fusion®
1. PowerPlex Fusion® samples are run with the WEN ILS500. ILS500 has a range of 60-500bp
(Fragments: 60, 65,80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425,
450, 475, 500). All size fragments must be labeled in the calibration chart and the orange dye lane.
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Yfiler ®
1. Y filer® samples are run with LIZ 500. The LIZ_Yfiler size template for LIZ 500 does not have the

250 bp sizing peak labeled as it is not utilized for data sizingt This peak shoulddot be labeled within

the Calibration Chart window. All other size calls in the range of 75-400 bp peaks must be properly

match scored/sized

When viewing the size standard in the orange dye lane in the Browsedy All Color, the 250bp will

be labeled. This peak is not being used for sizing:

100

1l.

139 150 160 200 300 340 350 400

6,000
v v 7Y A

1 A
4,000 v

2,000

i

T T T T T T T T T T T T T
2400 2600 2200 3000 3200 3400 3600 3200 400004200 4400 4600 4300

VI.Analyzing Sampleés

0 -

T T T T T T T T T T T
5000 5200 5400 5600 5800 6.000 6200 6400 6500 6800 7.000

Analysis of the data can be perfoermediin the Main Analysis window and/or the Browse by All Color
E£ window.

1. Adjust axis to view samples depending on amplification kit
Y,
a. On the top toolbar, Click Set Axis icon
b. Click Fixed ‘X’ — enter X axis range
1» PowerPlex Fusion® = 55-510
ii. Yfiler® = 75-410
c. Click Set Axis again — Select Auto Fit' Y

Note: Analysts can zoom in/out by using the zoom icons & located at the top toolbar. As an
additional option, hold down the left button on the mouse and drag the dotted box that appears from the
upper left to the lower right (around the desired “zoom in” area). To zoom out, hold down the left button
on the mouse again dragging box from lower right to upper left. To scroll while zoomed in, right click
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and hold while dragging the mouse in the direction you want to scroll.

2. Ifusing the Browse by All Color window, adjust Max Chart Number to 2

3. Analyst may choose to use the Peak Table EZ during analysis. Click the EZl icon to turn the

chart/table on and off.

4. Editing a peak
a. Click on Peak to Highlight — Right Click— Click Edit Comments— Select Edit
From List or Type New Edit (refer to edit code list) — Click OK.
b. To select multiple peaks for editing, Hold the Ctrl key + léft mouse click — Drag the
mouse to highlight intermittent peaks
c. Once the correct Edit is selected, highlight the peak and press Delete key to remove the
label from the peak.
d. To check peak history > Right clickon peak =Click view history
i. Any changes made to thegpeak will be listed n order from most recent down.
Click on any line to view specific change details in the Current/Old Values:
window. Scroll all the way.£o thewight to view edit code applied to peak in Allele
Comments column.
Note: If a label has been removed from a peak andineeds to be restored, Click on Peak to Highlight —
Right Click—Undelete. If an edit needs to be removed from a peak > right click on peak = click edit
comments = remove text from Comments: box so the text field is blank = Click OK (the E will still be
visible but the edit comment will be removed)

Note: Peaks will only beleonsideredistutter by the software if they are within 0.5bp from the parent peak.
If a stutter peak is >0.5bp from the parent peak the software will not automatically filter this out as stutter,
even if is under'theStutter filterpercentage for that location. +/- 4 stutter should not be manually edited
from evidence samplesdn Fusion. Stutter < 30% of the parent peak can be edited from Fusion positive
control samples and@xemplar samples..

5. Scheduling Re-Runs
a. If a sample Failed (over saturation, bad size standard, no data, etc..) > Right click on
sample in Sample Tree within Main Analysis Window = Click Edit Comments =
Type Re-Run Code in the comment box = Click OK
i. All peak labels must be removed from failed samples. Open the Browse by All
Color analysis window = navigate to the relevant sample(s) = highlight all
peaks in one dye by holding down Ctrl, left click and dragging around any peaks
present in that dye = click Delete to remove the peak labels=> repeat for each
dye
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b. If sample did not fail but re-run is desired - Right click on sample in Sample Tree
within Main Analysis Window = Click Edit Comments = Type Re-Run Code in the
comment box 2 Click OK

6. Over- Saturation
a. Check for saturated samples = In the Main Analysis Window electropherogram a pink
line will indicate the possible saturation of peak. This indicationswillalso be noted in the
Peak Table as <SAT> for that allele in the Allele Comment field. If the sample has
excessively saturated peaks (>10,000 RFU or split peaks)this sample must be rerun at a

dilution.

D6-2ng_DNAZc_FO1 011.fsa (06-2ng DNAZ) (RefLadder: 08-Alelic_Ladder_1 HOL015.fea) 4 ) 4 3
| 0851179 |
| THO1 |
| 0165539 |

AMEL
76 78 a0 8z 24 86
5,000}
4,000
3,000
2,000
1,000
0 =
i
52.2
5086
80.0
20.0
209

Mo, | FilaName Size Heigh§l | Allele Quality Allele Comments Sample Comments Qui #

1 06-Mng DMAZc F.. 78.9 4754 X [<5AT=] SD

2 05-2ng DMAZc_F.. 1247 38mf 16 Pass

2 MNE A NKAT- £ 179 N st

7. Once the entire run has been reviewed, all edits have been made and labels have been removed
from all edited peaks, on the top left corner of the screen, Click File — Click Save Project
You must save over the existing project every time you save

VII. Exporting for LIMS (all systems and sample types)
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1. In the Main Analysis Window = Click the down arrow next to the Show All Color icon = Click
Show All to turn on all colors before exporting
2. In the report display section of the main analysis screen, click on the down arrow next to the Save

Report icon = - . Ensure the “Save LIMS report” is selected.
a. Inthe LIMS report settings window that pops up, ensure the settingspare as follows:

The Size Range will be the same as the X- axis range for analysis:

90-340 for Yfiler and 55-510 for Fusion.

[ LIMS Report Settings

Dyes

v BLUE v RED

v GREEM gl NG
v TELLOW

[w.Show File Mame
{0 ShowS afiplesh ame

[v ShowBeleted Peaks
[© Bide F stra Sample M ames

| Ewrclide Report Header

Ok

N\ VvV =

ptiorg

V| Wiz Fangeibpst

From |55 ta 510
[ Abide By Panel
[ Grouped By Markers

Colurnsz. . ‘

¥ Show [~
[ Show Only Uncertain Alleles

Iv Show FRejected Low Score Alleles

Cancel

b. In Options, click on “Columns...”; use the Add/Remove buttons to ensure the Selected
Columns are present and listed in the order that follows:
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Selected Columnz

Plate 1D

kd arkeer

Dye

Size

Allele

Allele Carmments
Sample Comments

This is crucial to proper LIMS importation.

2. Click OK; Click OK again in the Allele Report Settings window. Save the file as type “Excel File
(*.xlsx;*.xls)” under the appropriate run name (make sure to deletesuffix “_AlleleReport”).
Navigate to the data entry screen for the corresponding testibatch in LIMS. Click Import Instrument

Data and import the excel file for the project.

VIII. Exporting Electropherograms (all system and sample types)

In the main analysis window,
- Click Set Axis > Click Fixed X axis The Size Range will be the same

as\the X- axis range for analysis:
ay 55-510 for Fusion
b. “90-340 for Yfiler
- 4 Select Auto Fit Y

1. (Click Tools=> Export Electropherogram

2. Set Output Folder to desired location for project PDFs by clicking J icon

Export Electroph erog‘ns @

Output Faolder: | MASTR_Datas(a_QChAthena 201 BMAthenal31416_10-11_2016-03-14% o

3. Ensure settings match below: Make sure to select PDF as export format
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Select Dyes

v ELUE

v| GREEM

| YELLOW

v| RED
ORAMGE

Dye Image Size

Wwidth: | 1024 pinels ’
Height: |700 pinels ‘ I

[ Oneimage per samplé
v Auto Scéle Size Range
[ Auto Scale Maiker Intepzity

Ewport Format: |F'DF file

In the suffix'field enterithe rufi name with a ““_ before it. (Ex: Newton061316 88-89U
A)

Printing the'ladder: Right click in the sample list = click Deselect All = Check the box
forthe ladder )In prefix field enter ladders_ > click Export

Printing the controls: Uncheck the box for the ladder and check the box for all controls in
the run > In the prefix field enter controls_ > click Export

Printing the samples: Right click in the sample list = click Select All > Uncheck the
box for all ladders and controls in the run, leaving all samples selected = clear the prefix
field - click Export. This will create 4 PDFs for every sample, one for each dye.

If analyzing Evidence:Wait to import PDFs into LIMS until after the completion of
STRmix analysis.

If analyzing Exemplars: Import all PDFs into LIMS.
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IX. Fusion Exemplars Only - Exporting EXEMPLAR table for

STRmix™ input (for evidence table instructions see section
XII)

1. In Main Analysis Window Click B - icon > Seleef'Show AlL In the report display

L,
section of the main analysis screen, click on the report settings icon . Make sure
settings match below:

Allele Report Settings o v @

Repart Style Option: =53
" Allele List | v Ewtend Diploid Homozygous
(s Fnrensn::a WS how Allele W ame
" Bin Tahle | [v Shai Size [0.1bps)
" Peak Table | | [v Show Height
" Allele Count I Show Area
D N y [ Show Scare

[w Show Filg Mame

I_ E
[ Sheoud 5 ample MName ]
- 4 [ Show Onlp Uncertain Alleles

| il rientation

(* Hetizantal  * Yertical

[v Show Rejected Low Score Alleles

v [~ Hide Extra Sample Mames
[ Exclude Sample Index [~ Exclude Report Header
Ok Cancel

2. In the report display section of the main analysis screen, click on the down arrow next to

the Save Report icon " . Ensure the “Save Report” is selected.

3. Navigate to appropriate folder and save file as “Run name SM”
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4. For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.
a. Open the exported project excel file from Step 1 above.

Open GeneMarker® to STRmix™ macro.

Follow the instructions on the “instructions” tab.

Change the file type to “.txt” (text, tab delimited)
Navigate to folder containing your project data and(save file thete.

a0 o

Fusion Evidence Only - STRmix™ Analysi$ (stutter filters
off)

Begin by importing the data from the initial analysis inte. LIMS to generate the edit sheet.
Have the edit sheet open in LIMS as yowperform the second analysis with stutter filters off
for STRmix™ to refer to and ensure the same editsiare being made the second time.

If Project is still open = Cliek RunProject ~ located in the top toolbar.

a. Ifproject is not open = Click File = Open Project = Navigate to run -> select

project > click open = Click Run Project > located in the top toolbar.

In TemplatefSelection window, select the appropriate existing template.

Template Mame: |FusiDn_STRmix

Panel: |Fusion_OCME_sTRmix Mo v | || &
Size Standard: |IL55IZIIZI ﬂM

Standard Color. | ORAMGE ]

Analyziz Type: |H|D J

4. Click Next

a. In the Data Process window, ensure the following settings are used based on
amplification Kkit.
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i. PowerPlex Fusion® STRmix™
[ Run Wizard @ﬁ

Data Process - HID Analysis

Set data process ophions

Faw Data Analysis Allele Call G N
v Auta Range (frame) i~ [~ Auta Range [bps)
a T 10000 5 Stat: [55 &= End '|5m =
v Smooth [ Enhanced Smaoth Peak. Detection Threzhold: _ﬂ

Iv Superior [~ Clazsic [ Enhanced
) ] Percentage>l ¥| Global Max
[~ Pullup Correction [v Spike Removal

| Saturation Repair

S S Min Irkensity: [500 =1 Masintensity: [72760 =
D .

l | [Hote dse Fanel Editor to set Min Intensity
. and, > Glakbal Max for peaks within kMarkers
Size Call &

f* Local Southern " Cubic Spline | I
y 1o

I save | BEl | << Back

Cancel

5. Click Next
6. In the AdditionalSettings’window, ensure the following settings are used.
a. Make sure Auto Select Best Ladder is selected
b. “Auto Panel Adjustment: Box is checked
c.\ Select the Positive Control Template using the Positive Control drop-down.
i. For PowerPlex Fusion® PP_Fusion
d. Under Allele Evalution Peak Score, Reject 0.00 and Pass 1.00
e. Deselect Mixture Evaluation
Note: Do NOT click Save within the Data Process Window. This will overwrite the template for all
analysts.
7. Click OK 2> A window will pop up:
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-

Use Old Calibration =

& Size Calibration

The internal lane sizes have been calibrated in the samples.
'ou may check Call Size Again to recall the sizes.

YWhat to do: I

Apply to Al Apply to Cureent

Check “Call size again” and Click Apply to All'2, Allow:data to process — Click OK

8. On the top left corner of the screen, Click File— Click Save Project = Save Project with
suffix SM

9. Perform a second analysis of this/run

a. Do not recheckor edit Ladder, Size Standard or Controls. Passing controls and
size standard are determined by the initial analysis.

b. In‘SampleTree.> Right click and disable every control in the project except the
LaddersEnter Comment “Not Used”

¢.pEnsure any samples that failed initial analysis are disabled.

d. Remove the labels from the same peaks that were edited in the initial analysis. It
iS not necessary to enter edit codes again.

e. If a sample had a rerun code during the initial analysis it is NOT necessary to
enter the rerun code again.

10. Once the entire run has been reviewed, and labels have been removed from all artifact peaks,
Click File — Click Save Project
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XI. Fusion Evidence Only - Exporting Electropherograms after
STRmix™ Analysis (samples only)

1. Inthe main analysis window, set the fixed X axis to 55-510 and set the Y axis to Auto Fit Y.
2. Click Tools> Export Electropherogram
3. Set Output Folder to the same location where the PDFs for the initial Fusion analysis of

the same project were saved by clicking J icon

Export Electropherograms P \ E

Output Faolder: | MASTR_Datasa_QChAthena 201 BMAthenal31416_10-13C2016-0344% o

4. Ensure settings match below:

Select Dpez

| BLLE

¥| GREEN

| YELLOMW

vIEED
DRAMNGE

Dye Image Size

|Width: 1024 pirels
| Height: |700 pizels

[ Oneimage per zample
[v Auto Scale Size Range
[ Auto Scale Marker Intensity

Ewport Format: |POF file -

5. In the suffix field enter the run name with a “_ before it followed by _SM (Ex:
_Newton061316 88-89U A_SM) to indicate STRmix™ analysis.

6. Printing the samples only: Right click in the sample list > click Select All = Uncheck the
box for all ladders and controls in the run and any samples that were disabled or failed,
leaving only the passing samples = clear the prefix field = click Export. This will create 4
PDFs for every sample, one for each dye.
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7. Import all PDFs (initial Fusion analysis and STRmix analysis) at the same time into LIMS.

XII. Fusion Evidence Only - Exporting EVIDENCE table for
STRmix™ input

1. In the report display section of the main analysis screen, click on the report settings icon

CE .
. Make sure settings match below:

Allele Report Settings y 4R w

e

Repart Style Options . V4
" Allele List [v Extend Diploid Homazegous
fe Fu:urensu:& [v Show Allele Mame
" Bin Table WS how Size0slbps)
" Peak Tahle | I Shaw Height
7 Allele Count [ Show Area

A [ Show Scaore

N

[v Show File Mame

N shou [
[ Show SampleM ame ]
I . € 4 | Show Only Uncertain Alleles

Urieggfon™ S [v Show Fejected Low Scaore Alleles
{* Harizontal . {* Yertical ]
S 6 S [ Hide Extra Sample Mames

| [ ExchudelSarmple Index [ Exclude Report Header
ok Cancel
5. ClickOK
6. In the report display section of the main analysis screen, click on the arrow of the Save
Report icon = - .
Click Save Report.

8. Navigate to appropriate folder and save file as type “Excel File (*.xlsx;*.xls)”” under the
appropriate run name (make sure to delete suffix “ AlleleReport”). Click Save.

9. For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.
a. Open the exported project excel file from Step 1 above.
b. Open GeneMarker® to STRmix™ macro.
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c. Follow the instructions on the “instructions” tab.

d. After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
h. Change the file type to “.txt” (Text, tab delimited)

i. Navigate to folder containing your project data and save file there.

XIII. Reporting Analyst/Case Tech Reviewer Sample Review

1. Verify all STR runs associated with case file samples checking for:
i. Passing Allelic Ladder was used to analyze run
ii. Passing controls were present
iii. Passing Size Standard for relevant case file samples
iv. Appropriate edits were made for relevant case. file'samples and labels were
removed from edited peaks
v. Any relevant samples needing re-run were scheduled and/or disabled
2. Determine if sample is suitable for comparisen/STRmix™ analysis
3. If atrue OL/OB was detected in a sample the allelémmust be assigned a call for STRmix™
i. Open STRmix™ .txt input file andxeplace OL/OB call with true call
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HELPFUL ICONS INDEX
Main Toolbar Icons
‘ Icon ‘ Name Function
Run Opens Run Wizard for processing the data
o Project '
Show/Hide | Allows user to show/hide the frames for'the Sample File Tree, Synthetic
% B B Toggles | Gel Image and Report Table, respectively:
Allows user the'choice of wiewing/hiding all color lanes or single dye
Show oy 8 . . oo
— Col lane layer (with single left mouse click on the icon, obtain single dye
e - olor view)
Zoom Allows for more discriminate view of electropherogram. Alternately,
00 hold down left mouse button and draw a box; dragging from top left
In/Zoom . . . . ;
corner to bottom right zooms in on image while dragging from bottom
@ O Out .
LN right corner to top left zooms out.
Default sets Y-axis by maximum peak intensity for the sample
Set Axi displayed. The other 2 options either auto-fit the Y-axis by the peak
‘Z;( et AXIS intensity of the alleles displayed, or allow for setting the X- and Y- axes
ranges manually.
Allows for comparative view display of sample electropherograms by
Browse by L
All Color dye color. Individual samples can be selected from the drop down menu
g 00TS 1 in the upper right corner of the All Color Browser display window.
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Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must be selected

‘ Icon Name Function
(A Size . S . . .
Calibration Displays calibration charts for linearity of lane analysis.
Show Allows user to toggle the display to show, only the Peak Table, the Peak
Chart/Table | Table and the Electropherogram,or just the Electropherogram.
Save Peak | Allowsuser to export the Peak Table as an Excel(.xls) file or a tab-
Table delimited,Text (-txt) file.
.
Allows user to call alleles by sample(s), by marker or by dyes. Allows
CallRilgle | st to make some modifications to the threshold/filter settings without
having'to activate Run Wizard again (i.e. Peak Detection Threshold,
A . Stutter Peak Filter and Peak Score Threshold).
Marker. |-None- " Marksg Allows user to select a marker to view. Available after the samples have
Drop-down
- been compared to a Panel.
Menu
£ . . .
Event Log | Displays the processing success/failure of each dye lane.
<l ‘I;I/Iligic(l Activates the Start Your Project, Run and/or Report dialog boxes.
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Browse By All Colors Icons

| Icon Name Function
® 0 Zoom
AT In/Zoom | Same use as in the Main Analysis Scteen.
Out
Show/Hide Allows user the option to show/hidedX- and Y- axis grid lines that
3 Mouse . . ..
e appear at the tip of the'mouse cursor along with the basepair size
Bl Cross ]
. and RFU valuelof the mouse cursor position.
Lines
-(\..- Sho;;v{ll;llde Allowsdiserithe option to show/hide the Bin brackets at the top and
= ! bottom of the electropherogram.
Ranges
— Allows user the option to adjust the RFU intensities of low peaks to
| TAY Auto'Scale | match the intensity of the highest peak in the dye color. When low
— Markersys| peaks are increased, the intensity magnification factor is noted in
the marker (can adjust from 2X to 8X).
= . Opens the Print Report settings box. Also accessible in the Main
Print .
Analysis screen.

Report Table Icons located directly above the Report Table.

Icon Name Description
Report Allows user to customize Report Table display settings.
Settings
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] Save Allows user to export the Report Table as an Excel (.xls) file or tab-
— Report delimited Text (.txt) file.
Cus];(?;mze Allows user to select which bins to include/excliide inthe, Report Table
— Collllmn (check with TSL as this is not accessible at this time)

PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of'the peak (y-axis)
Height Ratio peak height divided by height of highest peak in the dye lane or
Marker
indicates the area under the curve of the peak; calculated based on x-
Area . .
axis Start/End columm settings
Area Ratio peak area divided by area of highest peak in the dye lane or Marker
Marker locus location ofithe peak
bin location of the peaki(based on kit/system panel and ladder analysis
Allele :
of project)
. absolute value of'distance between the peak center and Bin center in
Difference b .
asepairs
assigns Pasg/Check/Undetermined quality ranking for each peak
Quality relativesto the Allele Evaluation Peak Score settings in the Run
Wizard (see Additional Settings)
an exponential curve based evaluation of the peak; calculation of the
Score value is based on signal-to-noise ratio and peak shape (or
morphology)
Start/End beginning and finish basepairs of the peak's Area calculation
Allele software and user edited comments for the peak; right mouse click
C ¢ peak in chart to add peak edit comments or select from the drop down
omments list (more in Edit Comments Index)
user added comments for the sample; right mouse click sample name
Sample . ad lo edi lect f h
Comments in the samplg tree to add new sample edit comments or select from the
drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
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Reasons assignment if ranked Check/Undetermined
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